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Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits,
software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and
damages incurred by you or third parties arising from the use of these circuits, software, or information.

Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents,
copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical
information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and
application examples.

No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas
Electronics or others.

You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics
disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification,
copying or reverse engineering.

Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended

applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment;
home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication
equipment; key financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other

Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a

direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious

property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military

equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising

from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other

Renesas Electronics document.

When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General
Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the
ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation
characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of
the use of Renesas Electronics products outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products
have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless
designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing
safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in the event
of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to
redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.
Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of
the final products or systems manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each
Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate
the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics
products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or
losses occurring as a result of your noncompliance with applicable laws and regulations.

Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use,
or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control
laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or
transactions.

It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or
otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this
document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or
Renesas Electronics products.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly

controlled subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)




General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas.
For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well
as any technical updates that have been issued for the products.

1. Handling of Unused Pins

Handle unused pins in accordance with the directions given under Handling of Unused Pins in the

manual.

%, The input pins of CMOS products are generally in the high-impedance state. In operation with an
unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false
recognition of the pin state as an input signal become possible. Unused pins should be handled as
described under Handling of Unused Pins in the manual.

2. Processing at Power-on

The state of the product is undefined at the moment when power is supplied.

%, The states of internal circuits in the LSI are indeterminate and the states of register settings and
pins are undefined at the moment when power is supplied.

In a finished product where the reset signal is applied to the external reset pin, the states of pins
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at
which resetting has been specified.
3. Prohibition of Access to Reserved Addresses
Access to reserved addresses is prohibited.

%. The reserved addresses are provided for the possible future expansion of functions. Do not access
these addresses; the correct operation of LSI is not guaranteed if they are accessed.

4. Clock Signals
After applying a reset, only release the reset line after the operating clock signal has become stable.
When switching the clock signal during program execution, wait until the target clock signal has
stabilized.

% When the clock signal is generated with an external resonator (or from an external oscillator)
during a reset, ensure that the reset line is only released after full stabilization of the clock signal.
Moreover, when switching to a clock signal produced with an external resonator (or by an external
oscillator) while program execution is in progress, wait until the target clock signal is stable.

5. Differences between Products

Before changing from one product to another, i.e. to a product with a different part number, confirm

that the change will not lead to problems.

% The characteristics of Microprocessing unit or Microcontroller unit products in the same group but
having a different part number may differ in terms of the internal memory capacity, layout pattern,
and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a
product with a different part number, implement a system-evaluation test for the given product.




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fithess for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Smart Configurator) for RX together with the CS+ IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX72T microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX72T Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK Renesas Starter Kit for R20UT4272EG
hardware. RX72T User’s Manual
Tutorial Manual Provides a guide to setting up RSK environment, | Renesas Starter Kit for R20UT4273EG
running sample code and debugging programs. RX72T Tutorial Manual
Quick Start Guide Provides simple instructions to setup the RSK Renesas Starter Kit for R20UT4274EG

and run the first sample. RX72T Quick Start Guide
Smart Configurator Provides a guide to code generation and Renesas Starter Kit for R20UT4275EG
Tutorial Manual importing into the CS+ IDE. RX72T Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK. Renesas Starter Kit for R20UT4271EG
RX72T Schematics
Hardware Manual Provides technical details of the RX72T RX72T Group Hardware RO1UHO803EJ
microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thi§ is a Digilent Pmod™ ngpatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK Renesas Starter Kit
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


http://www.digilentinc.com/index.cfm
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Renesas Starter Kit for RX72T R20UT4275EG0100
Rev. 1.00
Nov 30, 2018

1. Overview

11 Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE
Smart Configurator to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with CS+

« Code generation using the Smart Configurator.
« User circuitry such as switches, LEDs and a potentiometer

The RSK board contains all the circuitry required for microcontroller operation.

R20UT4275EG0100 Rev. 1.00 e
Nov 30, 2018 RENESAS



Renesas Starter Kit for RX72T 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator for the RX family
together with the CS+ IDE to create a working project for the RSK platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the Smart Configurator for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
o ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
o ‘Debug’ is a project built with the debugger support included. Optimisation is set to zero.

o ‘Release’ is a project with optimised compile options (level two) and no ‘Outputs debugging information’
options not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

R20UT4275EG0100 Rev. 1.00 e
Nov 30, 2018 RENESAS




Renesas Starter Kit for RX72T

3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX72T
MCU, ready to generate peripheral driver code using Smart Configurator. This project generation step is
necessary to create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:

Windows™ 7: Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

Windows™ 8.1 & 8: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850) icon
Windows™ 10: Start Menu > All Apps > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

e CS+ will show the Start Page. Use the
‘GO’ button to Create a New Project.

Create New Project

A new project can be created.
A new project can also be created by reusing the file configuration registered to an existing project.

e In the ‘Create Project’ dialog, select

‘RX* from the ‘Microcontroller’ pull-
down.
e In the ‘Using Microcontroller list

control, scroll down to ‘RX72T and
expand the tree control by clicking ‘+’.
Select ‘R5F572TKCxFB(144pin)’.

e Ensure that in the ‘Kind of project’ pull-
down, ‘Application(CC-RX)’ is selected.

e Choose an appropriate name and
location for the project, then click
‘Create’.

Note: this tutorial assumes the project
is named and located at the place
shown opposite.

e If the folder entered cannot be found a

Create Project X

Microcontroller: Fx w
Lsing microcontroller:

E}'é:&ezr:l’ microcontroller) Update. ..

I RSF572TKAFP(100pin) | | Product Name:R5F572TKCxFB
W R5FETZTKExFP({100pin) On-chip ROM size[KBytes]:1024

RBFB72TKCxFB(144pin) On-chip RAM size[Bytes]: 131072

Addtional Information:Package=PLQPOT44KA-B
W REF572TKCFP{100pin) I R R

M REFSTZTKGxFP(100pin)

L

Kind of project: Application{CC-RX) w
Project name: SC_Tutorial
Flace: C\Workspace ~

Make the project folder

‘Question’ dialog will be displayed; C\Wlorkspace|SC_Tutorial\SC_Tutorial mipj
C“Ck Yes . [] Pass the file compasition of an existing project to the new project
Project to be passed: Browse...
Copy composition files in the diverted project folder to a new project folder.
Create Cancel Help

Nov 30, 2018




Renesas Starter Kit for RX72T

3. Project Creation with CS+

e CS+ will create the blank project with
the standard project tree. A ‘Smart
Configurator’ node may also be
shown, if previously enabled.

@3 sC_Tutorial - CS+ for CC - [Property]

File Edit View Project Build Debug Tool Window Help

@&, start | [} H @ X

NI N R

FOPER DPB3Q I

f‘ Solution List

!| Project Tree

¢ @ 2|3

7 x

% Property

a_ﬁ SC Tutorial (Project

E R5F572TKCxFE (Microcontroller)

Jenuegy pewg 5

Smart Configurator (Design Tool] !

A, CC-RX (Build Tool)

2P File

-z RX Simulator (Debug Tool)
T) Program Analyzer (Analyze Tool)

Smart Configurator Property

~ Smart configurator seiting

Smart Configurator for R executable file path

R20UT4275EG0100 Rev. 1.00
Nov 30, 2018
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Renesas Starter Kit for RX72T 4. Smart Configurator Using the CS+

4. Smart Configurator Using the CS+

4.1 Introduction

The Smart Configurator for the RX72T has been used to generate the sample code discussed in this
document. Smart Configurator for CS+ is a tool for generating template ‘C’ source code and project settings
for the RX72T. When using Smart Configurator, it supports user with a visual way of configuring the target
device, clocks, software components, hardware resources and interrupts for the project. Thereby bypassing
the need in most cases to refer to sections of the Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called SC_Tutorial. A fully
completed Tutorial project is contained on the RSK Web Installer

(https://www.renesas.com/rskrx72t/install/cs) and may be imported into CS+ by following the steps in the
Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. Custom code should be added, whenever possible, in between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK.

Following a tour of the key user interface features of Smart Configurator and the reader is guided through
each of the peripheral function configuration dialogs in §4.2. In §5, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

R20UT4275EG0100 Rev. 1.00 REN ESNS Page 12 of 69
Nov 30, 2018
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Renesas Starter Kit for RX72T 4. Smart Configurator Using the CS+

4.2 Project Configuration using Smart Configurator - Overview page

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the Smart Configurator Usage.
You can download the latest document from: https://www.renesas.com/smart-configurator.

Smart Configurator will start up by double clicking on “Smart Configurator(Design Tool)” on the project tree.
The Smart Configurator initial view is displayed as illustrated in Figure 4-1.

G smart Configurator

- X
File Window Help
- =gl
% SC_Tutorialscfg &2 = O ||=# MCUPackage 2 =g
Overview information % & =R pe

- General Information ® 5

This editer allows yeu to medify the settings stered in configuration file (:scfg)

Board

Allow board and device selection

Application under
Clocks development
Allow clock configuration = Companents
Middleware

Components Device -

RENESAS

RTOS

e

Allow software component selection and configuration driver
= Fins RX72T
Pins

Allow general pin cenfiguration and pin configuration for selected software compenent RSEST2TKCaFE

Interrupt

Allow general interrupt configuration and interrupt configuration for selected software component

~ Current Configuration

Selected board/device: RSFS72TKCxFB (ROM size: 1024Kbytes, RAM size: 128Kbytes, Pin count: 144)
Overview | Board | Clocks | Components | Pins| Interrupts » Legend
& Console &2 S b B o 2~ 9+ = B ||[E Configuration Problems &3

Smart Configurator Output 0items

M@5680081: Pin 18 is assigned to EXTAL Description - Type
MB5@@eeal: Pin 16 is assigned to XTAL

Figure 4-1 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project that builds and runs without error.

R20UT4275EG0100 Rev. 1.00 RENESAS Page 13 of 69
Nov 30, 2018
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Renesas Starter Kit for RX72T 4. Smart Configurator Using the CS+

4.3 Board configuration page

On the board setting page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-2.

48} SC_Tutorial.scfg 12 = =
Device selection o=
Device selection B ed

Board: Custom User Board v
Device: | RSF372TKGFB
Dewnload more boards...
Ovenview| Board Clocks| Components | Pins | Interrupts

Figure 4-2 Board configuration page

4.31 Board configuration

From the default 'Custom User Board', select 'RSKRX72T' from the pull down and change it.
48% SC_Tutorial.scfg 52

Device selection

Device selection
Board: | Custormn User Board W
=
Device:

ustom LUser boar

Figure 4-3 Select board

As shown in Figure 4-4, when the confirmation dialog of board change is displayed, please click the
'Continue’ button and continue the subsequent procedure.
[ Confirm board change ¥

% Changing the board will refresh all pin assignments.
V' Assigned pins that are unavailable in the selected board may be removed.

Do you want to continue?

ISave and continuell Continue | Cancel

Figure 4-4 Confirm board change

R20UT4275EG0100 Rev. 1.00 :{ENESAS Page 14 of 69
Nov 30, 2018



Renesas Starter Kit for RX72T 4. Smart Configurator Using the CS+

4.4 Clocks configuration page

Clocks configuration page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected to
‘r_bsp_config.h’ file in ‘Smart Configurator\r_config’ of project tree.

441 Clocks configuration

Figure 4-5 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on-board 24 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-5.

Set VCC and AVCC to 3.3(V).Then, do not use Negative Voltage Input Settings of Analog Voltage Settings
uncheck the check box.

L "
19 *SC_Tutorialscfg 3 = =
. .
Clocks configuration o &
.
e SCHCR (ROLE[AN FlashlF clock (FOLE)
Fraguancy Division 5 =
! x4 = 500 (MHz]
x1 b
I SCHCR (CLKIAN iy s
| Main clock Fraguancy Multiplication: . STouEls 1
A 200.0 [MHz:
Qs ion souree: | R r a = 4 L
5 ation sourca: &50 Nt o v w250 =
[ [PCLEATAON) -
Fraquancy: | B [MHz] SCECR (PCLKAIIL) Peripheral modulke clock (PCLKA)
x172 = 100.0 {MHz)
Oscillation wait time: _ R
SCHCR [PCLKE[3:00) Peripherl moduke dod (PCLKE)
=l-1E fus] actual valus: 10000.000 us xiid = i (MHz)
SCKER {ECENE T} Perpheral moduk clock (PCLKC)
x1 = 200.0 (MHz)
SCEERECEROELH Perpheral moduk clock (PCLKD)
x4 = 50.0 (MHz)
HOCGD clock S
SCHCR (BCKIA.0N) External bus clock (BCLK}
xlfd - S0.0 (hHz)
|
BCKCR (BCLKDV)
SCHCRZ (UCK[2LT LISE claek (UCLK)
‘ LOCD elack
‘ IWDT-gadicated on-chip clock
CANMCLE/CACMOLE
8 (MHz)
-
¥ Analog Voltage Settings
Supply Voltage MNegative Voltage Input Settings
avee:l 33 ) AMNDOO: Enable | AN100: Enable
ANDOT: Enable | AN101: Enable
AMNDD2: Enable | AN102: Enable
PGAVSSD: Enable | PGAVSST: Enable
Owverview | Board ICIu:-cksI Components | Pins | Interrupts

Figure 4-5 Clocks Configuration page
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Renesas Starter Kit for RX72T 4. Smart Configurator Using the CS+

4.5 Component page

Drivers and middleware are handled as software components in Smart Configurator. Component page allows
user to select and configure software components.
8% SC_Tutorial.schg 33

Software component configuration

Components = e Configure
L
type filker text
w [ Startup
~ [= Generic
& rbsp

Overview | Board CIock;lComponentsIPins Interrupts
Figure 4-6 Component page

451 Add a software component into the project
Smart Configurator supports four types of software components: Startup, Drivers, Middleware and Application.

In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click ‘Add component’ & icon.

d_ﬁ;’ SC_Tutonal.scfg &3
Software component configuration

Components = 2w Configure

type filter text

v = Startup
w [ Generic
& rbsp

Figure 4-7 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

EG New Component O X
Software Component Selection
Select component from those available in list ldj

Type Drivers ~

Function

Filter

Cmrammman £ Tiema Vareimm

Figure 4-8 Add a Software component (2)
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4.5.2 Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. CMT1 and CMT2 will be used as
timers in de-bouncing of switch interrupts.
Select ‘Compare Match Timer’ as shown in Figure 4-9 below then click ‘Next'.

S New Component O *
Software Component Selection
Select component from those available in list tl:r
Type I Drivers VI
Function | All ~
Filter | |
Compenents Type Version Q
LB C Codal i 130
[ { tH Compare Match Timer Code Generator 1.5.0
SMpIEmEntary TOE T LOUE Generator T0
B2 Continuous Scan Mode $12AD  Code Generator 1.3.0
8 CRC Calculator Code Generator 1.3.0 "
Lo S RN - - - - -
£ >

Show only latest version

Description

This software component provides configurations for 16-bit/32-bit timer with module
CMT/CMTW and can generate interrupts at set intervals.

Download more software components

® < Back MNext = Cancel

Figure 4-9 Select Compare Match Timer

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTO0’ as shown in Figure 4-10
below then click ‘Finish’.

& rew Component O *

Add new configuration for selected component |

Compare Match Timer

Configuration name: | Config_CMTO |
Resource: [cpaTo o |
CMT2
CMT3

?\' < Back Mext = Cancel
Figure 4-10 Select Resource - CMTO
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In the ‘Config_ CMTOQ’ configures CMTO0 as shown in Figure 4-11. This timer is configured to generate a high
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high

accuracy delays required in our application.

Components = :%:5 ~ Configure
b T Count clock setting
- @ PCLK/3 (O PCLK/32 (O PCLE/128 (O PCLE/S12
type filter text
v & Startup 75 Compare match setting
W [ Generic Interval value |1 I Ims VI(ActuaI‘.-'aIuE: i)}
@ rbsp Register value (CMCOR) 6249 |
w (= Drivers
v (= Timers Compare match interrupt (CMID)
= Config_CMT0 ; ;
MR Priority |ievei 10 iv]

Figure 4-11 Config_CMTO setting

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->

Resource, select ‘CMT1’ as shown in Figure 4-12 below then click ‘Finish’.

[EG Mew Component O *
Add new configuration for selected component |
Compare Match Timer
Configuration name: Config_CMT1 |
Resource: CMT1 ~
CMT2
@' < Back MNext » Cancel

Figure 4-12 Select Resource — CMT1

Navigate to the ‘Config_CMT1’ and configure CMT1 as shown in Figure 4-13. This timer is configured to
generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in

this tutorial.
Components B [ 2~ Configure
= Count clock setting
OPCLK/E ® PCLK/32 (O PCLK/128 O PCLK/512
type filter text _
v (= Startup = Compare match setting
w [= Generic Interval value IZD I Ims VI(i\ctualvalue: 20)
B it Register value (CMCOR) [31249 |
w [= Drivers
v [= Timers Compare match interrupt (CMIT)
@ Config_CMTO i : :
p iLevel 10 P
& Config_CMT1 oty fLeve M

Figure 4-13 Config_CMT1 setting
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Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-14 below then click ‘Finish’.

G New Component O *
Add new configuration for selected component |
Compare Match Timer
Configuration name: | Config_CMT2 |
Resource: CMT2 ~

CMTO
CMT3 ‘
@ < Back Mext = Cancel

Figure 4-14 Select Resource — CMT2

Navigate to the ‘Config_ CMT2’ and configure CMT2 as shown in Figure 4-15. This timer is configured to
generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

Components [=| o Configure
= Count clock setting
- (O PCLK/SS (O PCLK/32 O PCLE/M28 @ PCLK/512

type filter text
v = Startup ~ Compare match setting

w = Generic Interval value IZOD I Ims VI (Actual value: 199,99744)

i Register value (CMCOR) [18530 |

w [= Drivers

~ [= Timers Compare match interrupt (CMI2)

& Config_CMTO
@ Config_CMT1
& Config_CMT2

Priority [ievei 10 v

Figure 4-15 Config_CMT2 setting
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4.5.3 Interrupt Controller

Referring to the RSK schematic, SW1 is connected to IRQ0(P10) and SW2 is connected to IRQ9 (PB3). SW3
is connected IRQ7(P20) and the ADTRGON. Tutorial used ADTRGOn and will be configured later in §4.5.7.

Click ‘Add component’ & icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

Select ‘Interrupt Controller’ as shown in Figure 4-16 then click ‘Next'.

IE New Component

Software Component Selection

Select component from those available in list

Type I Drivers

<

Function | All ~
Fiter | |
r
Components Type Version -
wl\ﬂnﬂﬁ Code Generator 130
r & Interrupt Controller Code Generator 1.5.0
TH Low Power Lonsumprion Code Generator T.5.0
B Normal Made Timer Code Generator 1.3.0
E\l Phase Counting Maode Timer Code Generator 1.5.0 v
L R - - e - - - -

Show only latest version

Description

interrupt, NMI pin interrupt and IRQ External pin interrupts.

Interrupt Controller configures the interrupt requests generated by ICU: Software

Download more software components

Configure general settings...

@ < Back I Next > I |

Cancel

Figure 4-16 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘ICU’ as shown in Figure 4-17
below then click ‘Finish’.

IE Mew Component

Add new configuration for selected component

Interrupt Controller

O X

=5

Configuration name: Config_ICU

Resource: ICU

&)

< Back Mext = | Finish
|

Cancel

Figure 4-17 Select resource —ICU
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Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-18

below.

Components B =

type filter text

v [= Startup
v [= Generic
& rbsp
v [ Drivers
v [= Interrupt
& Config_ICU
~ [= Timers
& Config CMTO
& Config CMT1
& Config CMT2

>

Configure

Software interrupt setting
[ Software interrupt
[ Software interrupt 2

MNMI pin interrupt setting
[CINMI pin interrupt

IRCYD setting
Eroe

IRQY setting
ml

IRQ setting
irRa2

IRQ3 setting
iR

IRC4 setting
ik

IR setting
Oiras

IRQE setting
OIras

IRQ7 setting
Oira7

IRQE setting
Jiros

IRQS setting
Eras

IRQ10 setting
Oirato

IRQ17 setting
Oiranm

IRQ12 setting
Oirat2

IRQ13 setting
Oira13

IRCY4 setting
Oirat4

IRQY5 setting
Oirats

Level 13 (highest)

Falling edge

Detection type | Falling edge ~ Digital filter

Priority |Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Detection type

Priority | Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 13 (highest)

w

Digital filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

No filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Figure 4-18 Config_ICU setting
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454 Ports

Referring to the RSK schematic, LEDO is connected to P54, LED1 is connected to P55, LED2 is connected to
P60 and LED3 is connected to P61. PA2 is used as one of the LCD control lines, together with PC5, P25 and

P26.

Click ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Ports’ as shown in Figure 4-19 then click ‘Next'.

ré Mew Component

Software Component Selection

Select component from those available in list

Type I Drivers

Function | All ~
Filter | |
Components Type Version &

B Port Output Enable Code Generator 1.3.0
‘B ports Code Generator 1.5.0 I
B PWM Mode Timer Code Generator 1.3.0
BB 5CI/SCIF Asynchroneus Mode Code Generator 1.3.0
B SCI/SCIF Clock Synchronous M...  Code Generator 130 v
L= = P P - b mem - - - - P
£ >

Show only latest version

Description

This software component provides configurations for General Purpose Input/Output.
Common features such as reading, writing, and setting the direction of ports and pins
can be configured. Enabling features such as open-drain cutputs and internal pull-

ups are also supported.

Download more software components

Configure general settings...

?) < Back

| MNext » I | Finish | Cancel

Figure 4-19 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-20

below then click ‘Finish’.

O X

B

!E MNew Component
Add new configuration for selected component
Ports
Configuration name: Config_PORT
Resource: PORT
?\ < Back Mext =

o ]| o

Figure 4-20 Select resource — PORT
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‘PORTZ2’, ‘PORTY’, ‘PORTE’, ‘PORTA, ‘PORTC’ tick box is checked as shown in Figure 4-21 below.

LITIITES =R Configure
ort selection
" . Port selecti
type filter text
v [= Startup ~ [JPORTD
v [= Generic
@& rbsp
w [= Drivers [/]PORT2
v [= Interrupt [(JpoRTs
& Config_ICU
v (= I/OPorts o
& Config_PORT
v = Timers [JpoRTs
& Config_CMTO
@ Config_CMT1 =ror
& Config_CMT2
CIPORTE
CIPORTG
CIPORTK

I roRT
] PoRT3
[ roRTT
[ rORTS
[ roRTE
[ roORTD
[ PORTF

[JPORTH

PORT2 PORTS PORT6 PORTA PORTC

Figure 4-21 Select Port selection

Navigate to the ‘Ports’ configure these four I/O lines and LCD control lines as shown in Figure 4-22, Figure
4-23, Figure 4-24, Figure 4-25 and Figure 4-26 below. Ensure that the ‘Output 1’ tick box is checked, except
P26. Select ‘PORT2’ tab.

Components =] }:;) ~  Configure
T = Port selection | PORT2 | PORTS PORT6 PORTA PORTC
type filter text
v [= Startup ~ [JApply to all
v & anenc Unused GPIO In Out Pull-up CMOS putput Output 1 MNormal drive output
& r_bsp
Dri
w [= Drivers P20
v [= Interrupt
*_ Config_ICU ®Unused GPIO O'in O 0ut [JPull-up CMOS output Output 1 Mormal drive output
v [= I/0OPorts
& Config_PORT P21
v = T.i_mers ®Unused GPIO O'in O 0ut [JPull-up CMOS output Output 1 Mormal drive output
& Config_CMTO
& Config_CMT1 P22
& Config_CMT2
®Unused GPIO O'in O 0ut [JPull-up CMOS output Output 1 Mormal drive output
P23
®UnusedGPI0 OIn - OOut  [JPull-up  CMOS output Output 1 Mormal drive output
P24
®Unused GPIO O'in O 0ut  [JPull-up CMOS output Output 1 Mormal drive output
P25
O Unused GPIO D In Pull-up CMOS output ~ MNeormal drive output
P26
CUnused GPIO OD'in Pull-up CMOS output w | [JOutput1 MNormal drive output
P27
@ UnusedGPIO Oln O0Out  [Pull-up  CMOS output Output 1 Mermal drive output
Figure 4-22 Select PORT2 tab
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Select ‘PORT5’ tab.

Components g oy~ Configure
= - Port selection PORT2 | PORTS | PORTE PORTA PORTC
type filter text
v [= Startup ~ [ Apply te all
v & aneric Unused GPIO In Cut Pull-up CMOS output Output 1
& r_bsp
w [= Drivers P50
w [= Interrupt
*_ Config_ICU @® Unused GPIO OIn (O Out DPull-up CMOS output Output 1
v [= I/0OPorts
& Config_PORT P51
v (= Timers @ Unused GPI0. OIn - OOut  [Pull-up | CMOS cutput Output 1
& Config_CMTO
.{ Config_CMT1 ps2
& Config_CMT2
®Unused GPIO Oin (O Out |:||3u||-up CMOS output Output 1
P53
®Unused GPIO Oin (O Out DPull-up CMOS output Output 1
P34
OUnused GPI0 Ol Pull-up  |CMOS output
P55
OUnused GPI0 Oln Pull-up  [CMOS output
Figure 4-23 Select PORTS5 tab
Select ‘PORTG tab.
Components g oy~ Configure
= - Port selection PORT2 PORTS | PORT6 | PORTA PORTC
type filter text
v [= Startup ~ [Japply to all
v & aneric Unused GPIO In Cut Pull-up CMOS output Output 1
& rbsp
w [= Drivers PEO
v [ Interrupt
& Config ICU OUnused PRI Ol Pull-up | CMOS output ~
v (= /O Ports
& Config_PORT P61
v (& Timers OUnused GPIO Oln Pull-up | CMOS output v
& Config_CMTO
f Config_CMT1 PE2
& Config_CMT2
@® Unused GPIO O'In (O Out DPull-up CMOS output Output 1
P63
@® Unused GPIO O'In (O Out DPull-up CMOS output Output 1
Pe4
@® Unused GPIO O'In (O Out DPull-up CMOS output Output 1
P65
®Unused GPIO Oin (O Out |:||3u||-up CMOS output Output 1

Figure 4-24 Select PORT®6 tab
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Select ‘PORTA tab.

Components | ::: ~ Configure
B - Port selection PORT2 PORT5 PORT6 | PORTA | PORTC
type filter text
~ [= Startup ~ [ Apply to all
ve Gsneric Unused GPIO In Out Pull-up  [CMOS output Output 1 Normal drive output
& r_bsp
~ [= Drivers PAD
v [ Interrupt
& Config_ICU ® Unused GPIO OIn O 0Out  [JPull-up CMOS output Output 1 MNeormal drive output
v [= I/O Ports
& Config_PORT PA1
v = T.i_mers ® Unused GPIO OIn O 0Out  [JPull-up CMOS output Output 1 MNormal drive output
& Config_CMTO
& Config_CMT1 e
& Config_CMT2
(O Unused GPIO (O In Pull-up CMOS output ~ Mormal drive output  ~
PA3
®UnusedGPI0 Olin O0Out  [JPullup  CMOS sutput Output 1 Mormal drive output
Pad
®UnusedGPI0 Olin O0Out  [JPullup  CMOS output Output 1 Mermal drive output
PAS
®UnusedGPI0 Olin - O0Out  [JPullup | CMOS output Output 1 Mormal drive output
PAG
®UnusedGPI0 Olin O0Out  [JPullup | CMOS output Output 1 Mormal drive output
PAT
® Unused GPIO  Oin O o0ut [ Pull-up CMOS output Output 1 MNormal drive output
Figure 4-25 Select PORTA tab
Select ‘PORTC' tab.
Components e - Configure
T = Port selection PORT2 PORT5 PORT6E PORTA | PORTC
type filter text
~ [= Startup ~ [ Apply to all
v & aneric Unused GPIO In Out Pull-up  |CMOS output Output 1 Normal drive output
& r_bsp
w [= Drivers PCO
v [ Interrupt
* Config_ICU ®Unused GPIO On O Out DPuII-up CMOS output Output 1 MNormal drive output
w [= /0 Ports
& Config_PORT PC
v & T.i_mers ®UnusedGPI0 Olin - O0Out  [Pullup  CMOS output Output 1 Normal drive output
& Config_CMTO
& Config_CMT1 e
& Config_CMT2
®Unused GPIO OIn O0ut  [JPull-up CMOS output Output 1 MNormal drive output
PC3
®UnusedGPI0 Olin - O0Out  [JPullup  CMOS output Output 1 Mormal drive output
PC4
® Unused GPIO  Oin O o0ut [ Pull-up CMOS output Output 1 Mormal drive output
PC5
O Unused GPIO OIn Pull-up CMOS output ~ Mormal drive output  ~
PCh
®Unused GPI0 Olin (O 0ut  [JPull-up CMOS output Output 1 Mormal drive output

Figure 4-26 Select PORTC tab
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45.5 SCI/SCIF Asynchronous Mode

In the RSKRX72T SCI11 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as shown

in the schematic.

Click ‘Add component’ % icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

shown in Figure 4-27 then click ‘Next'.

F6 New Component O *
Software Component Selection
Select component from those available in list .dj

Type I Drivers ~ I
Function | All ~
Filter | |
Components Type Version &
| H PWM Mode Timer Code Generator 120
lﬂil%g!{%g_lfl&synchmnous Mode Code Generator 1.3.0 I
SCIYSCIF Clock Synchronous M. Code Generator 1.3.0
H Single Scan Mode 512AD Code Generator 1.5.0
B Smart Card Interface Mode Code Generator 1.3.0 v
L ) v - . .. . - . - B P
< >

Show only latest version

Description

This software component provides configurations for SCI{SCIF) single{multi-
processor) asynchronous mode,

Download more software components

Configure general settings...

?) < Back | Next > || Finish | Cancel

Figure 4-27 Select SCI/SCIF Asynchronous Mode

Select ‘SCI/SCIF Asynchronous Mode’ as

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as
shown in Figure 4-28 below.

EE New Component O X

Add new configuration for selected component |

SCI/SCIF Asynchronous Mode

Configuration name: Config_5CN |

Work mode: Transmission/Reception i

Transmission

Resource:

Wsmission.’ﬁeception

‘ulti-processor Transmission
Multi-processor Reception
Multi-processor Transmission/Reception

?\ < Back Mext > Cancel

Figure 4-28 Select Work mode — Transmission/Reception
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In ‘Resource’, select ‘SCI11’ as shown in Figure 4-29 below.
EG rew Component O *

Add new configuration for selected component |

SCI/SCIF Asynchronous Mode

Configuration name: Config_5CH1 |

Work mode: Transmission/Reception ~

Resource: SCH w

scn
5CIs
5CI6
SCIg

s5Cha2 |

Figure 4-29 Select Resource — SCI11

Ensure that the ‘Configuration name’ is set to ‘Config_SCI11’ as shown in Figure 4-30 below then click ‘Finish’
FS New Component O et

Add new configuration for selected component |

SCI/SCIF Asynchronous Mode

Configuration name: Config_SCI1 |
Work mode: Transmission/Reception ~
Rescurce: SCIN |~
? < Back Next > I] Finish Cancel

Figure 4-30 Ensure Configuration name - Config_SCI11
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Configure SCI11 as shown in Figure 4-31. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD11 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

Components = Configure
=l FIFQ mode setting
- (® Mon-FIFO mode () FIFO mode
type filter text
v = Startup A Start bit edge detection s.ettlng
_*. r_bsp Data length setting
Selmines O 9 bits ® 8 hbits O 7bits
~ [= Interrupt
& Config_ICU Parity setting
v = /0 Ports (® Mone () Even () 0dd
& Config_PORT . .
v (= Communications Stop bit length setting
& Config SCIT1 @1 bit O 2 bits
v = Timers

=~ Config CMTD Transfer direction setting
& Config |

f Config_CMT1 (®) LSB-first (O MSB-first
@ Config CMT2 Transfer rate setting
Transfer clock Internal clock ~

16 cycles for 1-bit period

Bit rate I'IQEDD vI (bps) (Actual value: 19201.229, Error: 0.006%)
[JEnable medulation duty correction

SCK11 pin function SCK11 is not used ~

MNoise filter setting
[[]Enable noise filter

Clock signal divided by 1

Hardware flow control setting
® None QTS (ORTS11Z
15

FIFQ data setting

0
8
hd Data match detection setting
[[]Enable data match detection
0x00
Data handling setting
Transmit data handling Data handled in interrupt service routine ~
Receive data handling Data handled in interrupt service routine ~
Interrupt setting
TXI1 priority Level 15 (highest) ~
RXIT priority Level 15 (highest) ~
Enable reception error interrupt (ERIT1)
TEI1, ERI1 priority (Group ALD) Level 15 (highest) ~
Receive data ready interrupt Receive data full interrupt (RXI)
Callback function setting
Transmissicn end Reception end Reception error
Figure 4-31 Config_SCI11 setting
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45.6 SPI Clock Synchronous Mode

In the RSKRX72T SCI6 is used as an SPI master for the Pmod LCD on the PMOD1 connector as shown in

the schematic. Click ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SPI Clock Synchronous Mode’ as
shown in Figure 4-32 then click ‘Next’.

G New Component m} ®
Software Component Selection
Select component from those available in list 1jj

Type I Drrivers

Function |All ~
Filter | |
Compenents Type Versicn ~

B Smart Card Interface Mode Code Generator 1.3.0

EE‘SPICIuck Synchronous Maode Code Generator 1.3.0

B SPI Operation Mode Code Generator 1.3.0

ﬂ\foltage Detection Circuit Code Generator 1.3.0

E'Watc hdog Timer Code Generator 1.3.0 v
< >

Show only latest version

Description

This component provides clack synchronous operation of RSPl or SCI (Simple SPI
bus). It includes 4 transfer modes: Slave transmit/receive, Slave transmit, Master
transmit/receive and Master transmit.

Download more software components

Configure general settings...

?\ < Back I Mext > I | Einish I Cancel

Figure 4-32 Select SPI Clock Synchronous Mode

Ensure Operation, is set to ‘Master transmit only’ as shown in Figure 4-33 below.

ré MNew Component

Add new configuration for selected component

5P1 Clock Synchronous Mode

O

*

Configuration name: Config_RSPID

Operation: Slave transmit/receive

Slave transmit/receive

Resource: .
Slave transmit only

[vlg =
‘Master transmit only

Cancel

Figure 4-33 Select Operation — Master Transmit

R20UT4275EG0100 Rev. 1.00

Nov 30, 2018

RENESANS

Page 29 of 69



Renesas Starter Kit for RX72T 4. Smart Configurator Using the CS+

In ‘Resource’, select ‘SCI6’ as shown in Figure 4-34 below.

FE New Component O x
Add new configuration for selected component -Ha-
5P Cleck Synchronous Mode
Configuration name: Cenfig_RSPID |
Operation: Master transmit only ~
Resource: 5Cle ~
RSPID
sCH
SCI9
5CI1
sCh2
® = Back Mext = Cancel

Figure 4-34 Select Resource — SCI6

Ensure that the ‘Configuration name’ is set to ‘Config_SCI6’ as shown in Figure 4-35 below then click ‘Finish’

FG Mew Component O >
Add new configuration for selected component -Ha-
5PI Clock Synchronous Mode
Configuration name: Config_SCI6
Operation: Master transmit only -
Resource: 5CI6 R

@ ok ||t [ ]| conce

Figure 4-35 Ensure Configuration name - Config_SCI6
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Configure SCI6 as shown in Figure 4-36. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 8000 kbps. All other settings remain at their defaults.

Components =] v

-

type filter text

v [= Startup ~
v [ Generic
& rbsp
w = Drivers
v [ Interrupt
& Config_ICU
v [ /O Ports
& Config_PORT
w [= Communications
& Config_SCI11
& Config_SCI6
w [= Timers
& Config_CMTO
& Config_CMT1
& Config_CMT2

Configure

Transfer direction setting

() LSB-first

Data inversion setting
(@ MNormal

Transfer speed setting
Transfer clock

Bit rate

[JEnable modulation duty correction

Clock setting
[JEnable clock delay
Data handling setting

Transmit data handling

Interrupt setting
TXIE pricrity

TEIG priority (Group BLO)

Callback function setting

[ Transmission end

O Inverted

Internal clock (SCKE pin functions as clock output pin)

2000 (kbps)  (Actual value: 6230, Error:

[CJEnable clock polarity inversion

Data handled in interrupt service routine

Level 13 (highest)

Level 15 (highest)

-21.875%)

LY

Figure 4-36 Config_SCI6 setting
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4.5.7 Single Scan Mode S12AD

We will be using the S12AD on Single Scan Mode on the ANOOO input, which is connected to the RV1
potentiometer output on the RSK. The conversion start trigger will be via the pin connected to SW3. Click

‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘Single
Scan Mode S12AD’ as shown in Figure 4-37 then click ‘Next'.

G Mew Component O X
Software Component Selection
Select compenent frem those available in list ld:r
Type I Drivers ~ I
Function |All ~
Filter | |
Components Type Version 2
EESCI,."SCIF Clock Synchronous M...  Code Generator 1.3.0
H Single 5can Mode 512AD Code Generator 1.5.0 I
B8 Smart Card Interface Mode Code Generator 1.3.0
8 5PI Clock Synchronous Mode Code Generator 1.3.0
EE\‘ SPI Operation Mode Code Generator 1.3.0 v
= = . - - P - - e - P
< >

Show only latest version

Description

This software component provides single scan mode configurations for 12-Bit A/D
Converter which the analog inputs arbitrarily selected are cenverted for only once in
ascending channel order.

Download more software components

Configure general settings...

o

[==]

ack I Mext = I I Finish I Cancel

Figure 4-37 Select Single Scan Mode S12AD

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘S12AD0’ as shown in Figure
4-38 below then click ‘Finish’.

IE MNew Component

Add new configuration for selected component

Single Scan Mode 51240

a Pt

i

Configuration name: Config_5124D0

Resource: 512AD0

Cancel

Figure 4-38 Select resource — S12AD0
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Configure S12AD0 as shown in Figure 4-39 and Figure 4-40. Ensure the ‘Analog input channel’ tick box for
ANO0O0O is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’. All other settings
remain at their defaults.

Components B = :%:p ~ Configure
T ~ Basic setting
type filter text Analog input mode setting
v [= Startup A [[] Double trigger mode
ve G_enerl( Analog input channel setting
& rbsp
+ (= Drivers [+ ANDOOD [1ANDD1 [1AN002 C1ANDD3 [J ANDD4
v = Interrupt [ ano0s O anoos O anoo?
& Config_ICU
v (= A/D Converter Conversion start trigger setting
W Config 512AD0 Start trigger source IND conversion start trigger pin VI
v [= I/O Ports
@ Config PORT Interrupt setting

w [= Communications
& Config_5CI1
& Config_SCI6

v [= Timers * Advance setting

« Eun:!g’gm$? Add/Average AD value setting
& Config_

& Config CMT2 [ Anooo ANODT ANOO2 ANDO ANOO4

AMNODS ANDDE

Enable AD conversion end interrupt (S12AD1) Priority Level 15 (highest)

Self diagnosis setting
Mode Unused ~

ov

Disconnection detection assist setting

Charge setting Unused ~
15 ADCLE

Dedicated sample hold circuit channel setting

[ ano0o ANDDT ANO02

Programmable gain amplifier setting

Amplifier input setting (ANDDD~ANDDZ) Single-ended ~
AMND0D analog path selection A/D_ANDDD | CMPCDO_MNone | CMPCD1_None ~
4,000

A/D_ANDDT | CMPC10_None | CMPC11_None
x4.000
A/D_ANDOZ | CMPC20_Mone | CMPC21_None

14,000

Figure 4-39 Config_S12AD0 setting (1)

R20UT4275EG0100 Rev. 1.00 RENESAS Page 33 of 69
Nov 30, 2018




Renesas Starter Kit for RX72T

4. Smart Configurator Using the CS+

Data registers setting

Data placement

Automatic clearing
Addition/Average mode select
Addition count

Window function setting
(®) Disable

Window A/B operation setting

[JEnable comparison window A

A/D comparison A setting

Use comparator for ANODD
Use comparator for ANOD1

nna

Use comparator for ANDD2
Use comparator for ANDD3
Use comparator for ANDD4
Use comparator for ANDDS
Use comparator for ANDDG

Use comparator for ANODT

A/D comparison B setting

Input sarpling time setting

AMNDDD/Self-diagnosis

ADSTO output setting
["]Enable ADSTO pin output

Right-alignment ~
Disable automatic clearing ~
Addition mode ~
1-time ~
() Enable

[JEnable comparison window B

Window A comparison condition matched OR window B comparison condition matched

Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value

Reference data 0 > A/D-converted value

Unused

Reference data 0 > A/D-converted value

| (us)  (Actual value: 0.540)

(Total conversion time: 1.26us)

Figure 4-40 Config_S12AD0 setting (2)
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4.6 Pins configuration page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed at Pins page.

LE‘:-“ *SC Tutorialscfg 52

Pin configuration

Hardware Resource = B .’:lz 6%5
Type filter text
S Al ~

# Clock generator
£, Clock frequency accuracy measurement circuit
ﬁ-§ Buses
j;E EXDMA controller
# Interrupt controller unit
v . Multi-function timer pulse unit 3
w MTUO
MTU1
MTU2
MTU2
MTU4
MTU3
RATIIR

Pin Function  Pin Number

Overview | Board | Clocks Componentslnterrupts

Figure 4-41 Pin configuration page
4.6.1 Change pin assignment of a software component

To change the pin assignment of a software component in Pin Function list. Click 5% to change view to show
by Software Components.

LT:-:'(: *SC_Tutorial.scfg &3

Pin configuration

Software Components T B laz
Type filter text
Figure 4-42 Change view to show by Software Components
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Select the Config_ICU of software component. In the Pin Function list -> Assignment column, change the pin
assignment IRQO to P10, IRQ9 to PB3. Ensure the ‘Enable’ tick box of IRQ0 and IRQ9 are checked, as shown
in Figure 4-43.

Software Components =l |3, &% PinFunction ~h | t” -§ﬂ| By e
Type filter text type filter text All -
v i#: rbsp Enabled  Function Assignment Pin Number Direction Remarks

norh
2 rt'- P IRQD [# P10/MTIOCOB/MTCLKD/MTIOCOB#/MTCLKD#/GT...| # 141 [
v orts
e > Config PORT O IRQ1 # Mot assigned # Mot assigned  MNone
onfi
& 9- O IRQ2 # Mot assigned # Mot assigned  MNone
~ % Interrupt Controller . -
— Confio ICU O IRQ3 # Not assigned # Mot assigned Mone
— L - O IRC4 # Not assigned # Mot assigned MNone
v % Compare Match Timer . -
". Config CMTO O IRC5 # Mot assigned # Mot assigned  Mone
onfi
W C f'g_CMT1 O IRCE # Not assigned # Mot assigned MNone
onfi
W f'g_CMTE O IRQ7 # Mot assigned # Mot assigned  MNone
onti
- SCI'SCIF,QQ_ h Mod O IRC3 # Not assigned # Mot assigned MNone
v / synchrenous Mode
s Conf :;cn 1 IRQ9 | # PB3/AT/MTIOCOA/MTIOCOAZ/CACREF/SCKE/RSP... | # 48 I
onfi
& g- O IRQ10 # Mot assigned # Mot assigned  MNone
~ % SPIClock Synchrenous Mode . -
b > Config SCI6 O IRQ11 # Not assigned # Mot assigned MNone
*.' onta- O IRC12 # Mot assigned # Mot assigned  Mone
v % Single Scan Mode S12AD . -
e > Config S12AD0 O IRQ13 # Mot assigned # Mot assigned  MNone
onfi
& 9- O IRC14 # Mot assigned # Mot assigned  MNone
O IRQ15 # Mot assigned # Mot assigned  MNone
O NMI # Mot assigned # Mot assigned  MNone
£ >

Pin Function Pin Number

Overview | Board | Clocks | Components | Pins| Interrupts

Figure 4-43 Configure pin assignment - Config_ICU

Select the Config_SCI11 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD11 and TXD11 are checked and Assignment column of RXD11 is PB6 and TXD11 is
PB5 as shown in Figure 4-44.

Software Components = |2, &% PinFunction -2 | t” -§ﬂ| B3 e

Type filter text type filter text All ~

v i'!: r_bsp Enabled  Function Assignment Pin Number Direction Remarks
N b
“p ”:' P CT511# # Mot assigned # Mot assigned MNone
v orts
L Confia PORT RTS511# # Mot assigned # Mot assigned  MNone
o Tt D”t'gC* ol RXD11 [ PBS/TRDATAD/AZ/GTIOC2A/GTIOC2A%/RXD5/SMI...| # 40 [
v nterrupt Controller
b P SCK1 # Mot assigned # Mot assigned MNone

~ Config_ICU ’
o & Lonfig _ TXD11 |L#_PBS/TRSYNC/A2/GTIOC2B/GTIOC2B#/TXD5/SMO... | # 41 0
w oo Compare Match Timer

' Config_CMTO
w' Config CMT1
' Config_CMT2

~ . SCI/SCIF Asynchronous Mode
& Config_5CI11

~ % SPI Clock Synchronous Mode
& Config_SCI6

v % Single Scan Mode 512AD
& Config_512AD0

HOEROO

Pin Function Pin Number

Overview | Board | Clocks | Components | Pins | Interrupts

Figure 4-44 Configure pin assignment - Config_SCI11
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Select the Config_SCI6 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK6 and SMOSI6 are checked and Assignment column of SCK6 is PA4, SMOSIG6 is PBO
as shown in Figure 4-45.

Software Components = laz ﬁ% Pin Function =) | ‘.” _ﬂ‘ 3 e

Type filter text type filter text All ~

v ‘-5'; r_bsp
W r_bsp

v ‘-5'; Ports
@& Config_PORT

v ‘,5'; Interrupt Controller
@& Config_ICU

v ‘,5'; Compare Match Timer
' Config_CMTO
' Config_CMT1
' Config_CMT2

v ‘,5'; SCI/SCIF Asynchronous Mode
@& Config SCIT1

v ‘,5'; 5PI Cleck Synchronous Mode
i@ Config SCI6

v /% Single Scan Mode 512AD
@& Config 5124D0

Enabled  Function Assignment Pin Number Direction Remarks
SCKE | 7 PA4/AZ/MTIOCTB/MTIOCTBE/TMCIV/SCKE/TXDE... | # 55 10

SMISO6 # Mot assigned # Mot assigned MNone

SMOSIE | # PBO/AD/BCO2/A4/MTIOCOD/MTIOCODE/ TMOO/T... | # 51 10

5568 # Mot assigned # Mot assigned MNone

) 8 o

Pin Function Pin Number

Overview | Board | Clocks | Components | Pins | Interrupts

Figure 4-45 Configure pin assignment - Config_SCI6

Select the Config_S12ADO0 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of AN00OO, AVCCO0, AVSS0 and ADTRGO# are checked and Assignment column of ANOOO is
P40, ADTRGO# is P20 as shown in Figure 4-46.

Software Components = &% Pin Function -~ | t” -gr_'” &y 2
Type filter text type filter text All w
v i#: r_bsp Enabled  Function Assignment Pin Number Direction Remarks

b
#—..p ”:' P | ADSTO # Not assigned # MNotassigned None
v
= Eé i PORT ADTRGO# #_P20/D15/MTIOCIC/MTCLKE/MTIOCICE/MTCLKB... | # 101 [
onfi
s 9 ANODO #_P40/ANDDD/ CMPCDO/CMPCO1 7131 I
v 2 Interrupt Controller - .
- Config 1CU | AMODT # Not assigned # MNotassigned None
& Lonfig O ANDDZ2 # Mot assigned # Mot assigned Mone
v % Compare Match Timer . -
". Canfig CMTOD O ANDD3 # Not assigned # MNotassigned None
. Conf!lCMT‘l ] ANOD4 # Mot assigned # Motassigned Mone
onfi
v f'g_CMTE O AMNOD3 # MNot assigned # Mot assigned MNone
onti
g- | ANODOE # Not assigned # MNotassigned None
v L SCI/SCIF Asynchronous Mode
b M'C fig SCI1 | AMNOOT # Mot assigned # Motassigned MNone
onfi
- :I;I a lch_ N Mod AVCCO 7 MCCO 7134 None
v = oek synenranous Hode AVSSD 7 AVSSD 7135 None
@& Config_SCI6 I - r -
" ‘#: Single Scan Mode 51240 O PGAVSSD # Mot assigned # Motassigned MNone
& Config_S12AD0
< >

Pin Function Pin Number

Overview | Board | Clocks | Components | Pins | Interrupts

Figure 4-46 Configure pin assignment - Config_S12AD0

Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘el Generate Code’ at location of Figure 4-47.

{84 5C_Tutorial.scfg 32 = m

Pin configuration

Figure 4-47 Generate Code Button
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If the Section Setting Dialog is displayed as shown in the Figure 4-48, Please check the box and click “Yes”.

IE Section Setting

1 Current section setting of project may not be compatible with Smart Configurater
" Do you want te change section setting?

Current section setting:
B_1,R_1,B_2,R_2,B,R,5U,5/4, PResetPRG/FFFO0000,C_1,C_2, C,CSDSEC, CSBSEC, CSINIT,C
SVTBL,CSVECT,D_1,0_2,D,P,PIntPRG,W_1,W_2,W,L/FFFO0100,EXCEPTVECT/FFFFFF80,R
ESETVECT/FFFFFFFC
Mew section setting:
SU,S1,B_1,R_1,B_2 R_2 B,R/0x00000004,C_1,C_2,C,CS* D* W* L, P*/0xFFFOD00D, EXCEPTYV
ECT/0xFFFFFF80,RESETVECT/OxFFFFFFFC

[Yes] to change section setting
[No] to keep current section setting
[Cancel] to cancel code generation

X

Cancel

Figure 4-48 Section Setting Dialog

The Console pane should report ‘Code generation is successful’, as shown Figure 4-49 below.
E) Console 22
Smart Configurator Qutput

Medeaaaal
Medaaapal
Madaaapal
Madaeepal:
Madaeaaal:
Madaeapal
Med4eoe00l:
Medeaaaal
Madaaapal
MaseeeRl2:
Maseeeal2:
MacaeaRa2
Mecaaeae2;
MecaaaRa2
Meaaaaan2
Ma3eaapad

File
File
File
File
File
File
File
File
File
File
File
File
File
File
Code
File

generated:srclsmc

gen\general\r cg userdefine.h

generated:srchsmc

gen\general\r smc _entry.h

generated:srchsmc

gen\general\r cg hardware setup.c

generated:srchsmc

gent\general\r cg cmt.h

generated:srchsme

genl\general\r cg icu.h

generated:srclsmc

genl\general\r cg port.h

generated:src\smc

gen\general\r cg sl2ad.h

generated:srclsmc

gen\general\r cg sci.h

generated:srchsmc

gen\general\r cg rspi.h

generated:srchsmc

gen\r pincfg\Pin.h

generated:srchsme

gen\r pincfg\Pin.c

generated:srclsmc

genl\general\r smc interrupt.c

generated:src\smc

engeneralir smc interrupt.
3 1) s t.h

generated:srclsmc

gen\r confighr bsp interrupt config.h

generation is successful

modified:src\smc gen\r confighr bsp config.h

bR B -my= O

Figure 4-49 Smart Configurator console

When code generation is executed, the startup files generated at the time of CS+ project creation are replaced
with those generated by Smart Configurator. Figure 4-50 the project tree after code generation. In the next
chapter, user code is added to these files, and SC_Tutorial is completed by adding a new source file to the

project.

Project Tree o

; @ 8@

=20 )
icrocontroller)
:\ISmar‘tCUm‘igurator (Design Teol)
4y CC-RX (Build Tool)

.. R Simulator (Debug Tool)

’:) Pregram Analyzer (Analyze Tool)
&L File

t-| SC_Tutorial.c

-1} Smart Cenfigurator

5[ Config_CMTD

5[ Config_CMT1

5[ Config_CMT2

5[ Config_Icu

5[ Config_PORT

5[ Config_512AD0

5| Config_scIT1

5| Config_sCl6

j--_l general

o] r_bsp

j--_l r_config

j--_l r_pincfg

Figure 4-50 Smart Configurator folder structure
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5. Completing the Tutorial Project

5.1 Project Settings

e In the ‘Project Tree’ pane, select
‘CC-RX (Build Tool). The build
properties will appear in the main
window.

e C(CS+ creates a single build
configuration called ‘Default Build’ for
the project. This has standard code
optimisation turned on by default.

4, CC-RX Property
~ Build Mode
Build mode
Change property value for all build modes at once
~ CPU
Instruction set architecture
Uses floating-point operation instructions
Endian type for data
Rounding method for floating-point constant operations
Handling of denormalized numbers in floating-point constants
Precision of the double type and long double type
Replaces the int type vith the short type
Sign of the char type
Sign of the bit-field type
Selects the enumeration type size automatically
Order cf bit-field members
Assumes the boundsry alignment value for structure members is 1
Enables C++ exceptional handling function (try, catch and throw)
Enables the C++ exceptional handling function (dynamic_cast and typeid)
General registers used only in fast interrupt functions
Branch vidth size

Default Build

No

RXw3 architecture{isa=nw3)

Yes(fpu)

Little-endian data(-endian=litle)
round to nearest(round=nearest)
Handles as zeros(-denomalize=off)
Handles in single precision(<dbl_sizs=4)
No

Handles as unsigned charfunsigned_char)
Handles as unsigned{unsigned_bitfield)
No

Alocates from right (bit_order=right)
No(mpack)

No(-noexception)

No(tti=off)

None{fint_register=0)

Compiles within 24 bits(branch=24)

Base register for ROM None
Base register for RAM None
Address value of base register that sets the address value [==] 00000000
Register of base register that sets the address value None
Avoids a problem specific to the CPU type No
Saves and restores ACC using the interrupt function No
PICI/PID

Build mode

Selects the build mode name to be used during build

¢ H 1 ’ CC-RX P
e Select the ‘Compile Options’ tab at | |% cCfxfeeen
» Firs
the bottom of the properties window Language of the C sourcefile

pane. Under ‘Language of the C
source file’ select ‘C99(-lang=c99)’
as shown opposite.

Language of the C++ source file

Additionzl include paths

System include paths

Include files at the head of compiling units

Macro definition

Invalidates the predefined macro

Enzbles information-level message output
the number of inform -

Undisplayed messages

Changes the warning-level messages to information-level messages

Changes the information-level messages to warning-level messages

Changes the information-level and warning-level messages to error-level messages

Permits comment (* /) nesting

Checks the compatibility with an existing program

Character code of an input program

| messages

++{{ang=cpp|

Additional include paths[17]

System include paths[0]

Include files at the head of compiling units[0]
Macro defintion[0]

Mo(nomessage)

No

Ne

No
MNo(-comment=nonest)
No

SIS codef-sjis)

e Select the ‘Link Options’ tab at the
bottom of the properties window

~ Section
Section start address
The spesified section that outputs externally defined symbols to the file
Section alignment

SUSLB_1.R_1.B_2R_2B.R/4C_1.C 2.CC$" .D"W" L P*/Ft

The specified section that outputs extemally defined symbols ta the fie{0]
Section alignmert[0]

pane. Under ‘Section > ROM to T ] 1 0 AN magoee seco) =
RAM mapped section’, add the three
mappings as shown opposite.
e These settings are easily added by Text Edit ®
clicking the button ‘...” and pasting —
the following text into the dialog: ;=H
D_1=R_1
D_2-R_2

D=R
D 1=R_1
D 2=R 2

e This ensures that the linker assigns
RAM rather than ROM addresses to
C variables. Click ‘OK’

Cancel Help
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e From the ‘Build’ menu, select ‘Build | & sC_Tutorial - €S+ for CC - [Property]
Mode Settings...”. Click ‘Duplicate’ File Edit View Project |Build| Debug Toel Window Help
and in the resulting ‘Character String @, stert | I [ G| &4 Build Project F7

Input’ dialog, enter ‘Debug’ for the ) F gg | @ Rebuild Project Shife=F7
name of the duplicate Build Mode. O |ProjectTres | @ Clean Project

2 @ al@ Rapid Build

= ] ; 5 Update Dependencies

=|| &3 SC Tutorial (P

E .. J% RSFST2TK Build SC_Tutorial

Rebuild SC_Tutorial

Clean SC_Tutorial

Update Dependencies of 5C_Tutorial
Set Link Order of SC_Tutorial...

Open the Optimization Performance Comparison Tool for SC_Tutorial...

Stop Build Ctrl+F7

Build Mode Settings...

Batch Build...

Build Option List

Build Mode Settings X

Selected build mode:

Build mode list:
Default Build Duplicate...

e The new ‘Debug’ Build Mode will be Property
added to the Build Mode list. Click | |4, ccrxFropety
‘Close’.  Now, in the main CC-RX | |v BuildMode

: Defaul Build
Property W|nd0W, u nder the Change property value for all build modes at ence Default Build

‘Common Options’ tab, click on the | |¥ ¢PY
. .. . . y . Instruction set architecture TV STCIITECITET: 3T
line containing ‘Build Mode’, click the

pull-down arrow and select ‘Debug’
from the pull-down’.

e In the ‘Frequently Used Options (for Property
Compile)”  group, select the A, CCRX Propery

‘Optimization Level option and select > PICIPID
+ Dutput File Type and Path

0 from the pu”_down We have now Output file type Bxecute Module(Load Module File)
Created a ‘Debug’ Bu||d Mode with Intermediate file output folder %BuldModeName%

. . . + Frequently Used Options(jor Compile)
no code optimisation and will be > Additional include paths Additional include paths[16]
USing the BU|Id Mode to Create and »  System include paths System include paths[0]

. > Macro definition Macro definition[0]
debug the prOjeCt. Outputs debugging information Yes(debug)

Dptimization level
Outputs additional informaticon for inter-module optimization
Optimization type

Outputs 3 source listfile

+ Frequently Used Options(for Assemble)

Max-optimize=max)
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e All of the sample code projects
contained in this RSK are configured
with three Build Modes;
‘DefaultBuild’, ‘Debug’ and ‘Release’.
‘Release’ is created in the same way
as above; by duplicating ‘Default
Build’. ‘Release’ Build Mode leaves
code optimisation turned on and
removes debug information from the
output file.

e To remove debug information from
the ‘Release’ Build Mode, in the ‘CC-
RX Property’ window, select the
‘Common Options’ tab at the bottom
of the window pane. For the
‘Outputs  debugging information’
option, select ‘No(-nodebug).

e Reset the Build Mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.

e From the menus, select ‘File -> Save
All' to save all project settings.

# CC-RX Property
v Build Mode
Build mode
Change property value for all build modes at once
CPU
PIC/IPID
Output File Type and Path
+ Frequently Used Optons(for Compile)
Additional include paths
System include paths
Macro definition
Outputs debugging information
Optimization level
Outputs additional information for inter-module optimization
Optimization type
Outputs a source list file
Frequently Used Options(for Assemble)
w Frequently Used Options{for Link)
Using libraries

Optimization type
Section start address
+ Frequently Used Options(for Hex Output)

Release
No

Additional include paths[17]

System include paths[0]

Macro definition[0]

‘Yes(-debug)

2-optimize=2)

No

Optimizes with emphasis on code size(-size)
Mo{-nolistfile)

Using libraries[0]

Dutputs debugging information Yes (Outputs to the output file)(-DEBug)

Yes (Outputs to the output file)-DEBug)
‘Yes (Outputs to <out)
No{-NODEBug)

Ut file name::.dba file)-SDebug

5.2 Additional Folders

e Before new source files are added
to the project, we will create two
additional folders in the CS+
Project Tree.

e In the Project Tree pane, right-click
the SC_Tutorial project and select
‘Add -> Add New Category’.

Project Tree 2 X
¢t @2 @
=
[SRN ] =] Build SC_Tuterial
R3F372TKCxFE (M

Rebuild SC_Tutorial
Clean SC_Tutorial

d
4 Smart Configurat ﬁj
4, CC-RX (Build Too L4
5. RX Simulator (Deb o
b Program Analyzer e
File =

Open Folder with Explorer
Windows Explorer Menu

& SC_Tutorial.

; Add
|_l Smart Config

L4 | |+ﬁ Add Subproject...

fia| SetSC Tutorial as Active Project

Property

Save Project and Development Tools as Package... 1 AddfFile..
| Paste Cirl+V
#@ Rename 2 ||’ Add New Category

|+g Add New Subproject...

e Rename the newly-created ‘New
Category’ folder to ‘C Source Files’.
Repeat these steps to create a new
category folder for ‘Dependencies’.

Project Tree

; @ 8 &

EI,_ﬁ SC Tutorial (Project]

..... A, CC-RX (Build Tool)
----- e, R Simulator (Debug Tool)

-3 File

| SC_Tutorial.c

IJ_ Smart Configurator

----- % R3F3T2TKCxFEB (Microcontroller)
----- °;~| Smart Configurator (Design Tool)

----- f::' Program Analyzer (Analyze Tool)

; ﬂ Build tocl generated files
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Locate the files ascii.h, r_okaya_lcd.h, ascii.c, and
r_okaya_lcd.c in this folder. Copy these files into the C:\Workspace\SC_Tutorial\src folder.

« Move the ‘SC_Tutorial.c’ file from [ | B - | sCTutorial
‘C:\Workspace\SC_Tutorial to ULl Home | Share  View
‘C:\Workspace\SC_TUtorial\SrCI. “ v » ThisPC » Local Disk (C:) » Workspace » SC_Tutorial

MName ; - Daten

7+ Quick access b
Debug § 6/23/2
= This PC DefauItBuiI- 3 6/23/2
[ Desktop Release 6/23/2
Documents src - 6/23/2
4 Downloads ] dbsct.c 21872
J’ Music E hwsetup.c 773720
. E intprg.c 1/20/2
) Pictures [ iodefine.h 5/9/20
B videos [ towlvl.sre 21972
‘s Local Disk (C) E lowsrc.c 10724/
i Network owsreh 211972
N ) resetprg.c 271972
) shrk.c 271972
7 sbrk.h 211972
[ sC_Tutorial #%@EH.mtud 6/23/2
292
@) sC_Tutorial.mtpj 6/22/2

Project Tree

« Right-click on the ‘C Source Files’ folder and
i © 28 &

select ‘Add’ -> ‘Add File...". -
| f 5C Tutorial (Project)*
ﬁ R3F372TKCxFB (Microcontroller)

Ej Smart Configurator (Design Tool)
Ay, CC-RX (Build Tool)

él R Simulator (Debug Tool)

C@ Program Analyzer (Analyze Tool)
E||ﬂ File

! 'ﬂu Build tool generated files

Dl] Smart Configurator

-y Dependenci HEE
E.L Open Folder with Explorer 1] Add New File...
Bl Windows Explorer Menu iﬂ Add Mew Category
@ Remove from Project Shift+Del
33 Copy Ctrl+C
[ Paste Crl+V
@ Rename F2
ﬁ Property

« Select the files to be added (ascii.c, e
r_okaya_lcd.c’ SC_TUtOI’Ia') from C. “ L <« Workspace » SCTutorial » src » v O Search src R
\Workspace\SC_Tutorial\src. Sgmmy ot Er @ e
# Quick access teme
smc_gen
58 This PC 7 asciic
[ Desktop 3 r_okaya_led.c
Documents | sCTuterial.c
¥ Downloads
D Music
[&=] Pictures
B Videos
i Local Disk (C:)
b Network
< >
File name: | "SCTutorial.c" "ascii.c" "r_okaya_lcd.c" v| ‘CSDHICE'“EP.C} V‘
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Similarly, add ‘ascii.h’ and ‘r_okaya_lcd.h’ to the
'Dependencies' folder.

™ Add Existing File

& v A <« Workspace » SCTutorial » src » v &  Searchsrc o
QOrganize = New folder > [N 0
MName .
Note: Select the Header file (* .h; * hpp; * .inc). o Quicksccess ame_gen
O ThisPC ) asciih
[ Deskiop | r_okaya_lcd.h
5 Documents
4 Downloads
J) Music
| Pictures
B videos
“ia Local Disk (C:)
=¥ Network
< >
File name: ["r_okaya_lcd.h” “asciih’ v | [Header file ¢ “hpp: inc) v
[om ] one
« Make sure the project tree is the same as the Project Tree o x
screen shot. A
t @ 8 &

=L 1§ SC Tutorial (Project)”

----- % R3F5TZTECFB (Microcontroller)
----- °_,_j Smart Configurator (Design Tool)
..... 4 CC-RX (Build Tool)

----- e, R Simulator (Debug Tool)

..... "Ij' Program Analyzer (Analyze Tool)
o (PR

----- ﬂmﬂuild tool generated files
&L | Smart Configurator

EI[E C Source Files

..... | r_okaya_lcd.c
..... &-| SC_Tutorial.c
E[E Dependencies

..... b= asciih

..... i'_J r_ckaya_lcd.h
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Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for xxxxx . Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user needs to subsequently change any of the Smart Configurator-generated code.

In the CS+ Project Tree, expand the ‘src/smc_gen/general’ folder and open the file ‘r_cg userdefine.h’ by
double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for function. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’ by double-clicking
on it. Add header files above the ‘main’ function as shown below.

#include "r smc entry.h"
#include "r okaya lcd.h"

#include "r cg userdefine.h

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display (0, (uint8 t *)" RSKRX72T ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R LCD Display(2, (uint8 t *)" Press Any Switch ");
while (10)

{

}
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5.31 SPICode

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in §4.5.6. In
the CS+ Project Tree, expand the ‘Smart Configurator/Config_SCI6’ and open the file ‘Config_SCI6.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */
Now, open the Config_SCI6_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t gs sci6_ txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI6:
static void r Config SCI6 callback transmitend(void)
{
/* Start user code for r Config SCI6 callback transmitend. Do not edit comment generated here */

gs_sci6_ txdone = TRUE;

/* End user code. Do not edit comment generated here */

}
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

JHE KKK KK KKK KKK K KKK KKK KKK KKKK KKK KKK KKk kkhh kA A A KK KKKk ko kkh ok kA A KKK K& &k KKk kok ko

* Function Name: R SCI6 SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

*****************************************************kk************************/
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf,
const uintlé6_t tx num)
{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
gs_sci6_ txdone = FALSE;

/* Send the data using the API */
status = R Config SCI6 SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == gs_sci6_txdone)
{
/* Wait */
}

return (status);

}

/*******************************************************************************

* End of function R SCI6 SPIMasterTransmit

KAk Ak Rk kA Ak A AR AR A A A AR AR A A A AR ARk A A ARk Ak A A Ak kA kA kA kA Ak Ak A Ak A A AR A A A A KA KA KA A K AKX A KA KK

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in §4.5.2. In the CS+ Project Tree,
expand the ‘Smart Configurator\Config_ CMTO0\Config_ CMTO0.h’ and insert the following code in the user area
for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_CMTO0_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t gs one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config CMTO_cmiO_interrupt function and insert the following line in the user code area:

static void r Config CMTO cmiO_ interrupt (void)
{
/* Start user code for r Config CMTO cmiO interrupt. Do not edit comment generated here */

gs_one ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

VAR AR R R EEE RSt EEEEE R EEE R EEEEE et

* Function Name: R CMT MsDelay

* Description : Uses CMTO to wait for a specified number of milliseconds
* Arguments : uintl6 t millisecs, number of milliseconds to wait
* Return Value : None

********k*k**k*k*‘k‘k‘k‘k‘k‘k‘k~k*****************‘k*‘k‘k*‘k‘k*‘k~k‘k‘k‘k‘k‘k‘k‘k‘k‘k****************‘k‘k‘k‘k‘k‘k/
void R_CMT MsDelay (const uintlé t millisec)
{

uintlé_t ms_count = 0;

do

{
R Config CMTO Start();
while (FALSE == gs_one ms_delay complete)
{

/* Wait */

}
R _Config CMTO_Stop();
gs_one ms delay complete = FALSE;
ms_count++;

} while (ms_count < millisec);

}

/**********************************‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k**************************

End of function R CMT MsDelay

KKK K KKK KK K KK KK K K K K K K K K R R K K R R Rk K K R R R Rk R R R R Rk R R R R R R R R R A AR R R R A R Ak Rk R R Rk kR Rk Ak /

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The program will display ‘RSKRX72T
Tutorial Press Any Switch’ on 3 lines in the LCD display.
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5.4 Switch Code Integration

API functions for user switch control are provided with the RSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Locate the files rskrx72tdef.h, r_rsk_switch.h and
r_rsk_switch.c in this folder. Copy these files into the C:\Workspace\SC_Tutorial\src folder. Add these three
files into the project in the same way as the LCD files.

The switch code uses interrupt code in the files Config_ICU.c, Config_ICU_user.c and Config_ICU.h and timer
code in the files Config ICU.c, Config ICU user.c, Config CMT1.h, Config_ CMT1.c, Config CMT1_user.c,
Config CMT2.h, Config CMT2.c, and Config CMT2_user.c, as described in §4.5.2 and §4.5.3. 1t is
necessary to provide additional user code in these files to implement the switch press/release detection and
de-bouncing required by the API functions in r_rsk_switch.c.

5.4.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Smart Configurator/Config_ICU’ folder and open the file ‘Config_ICU.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */
uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no);

void R ICU IRQSetFallingEdge (const uint8 t irqg no, const uint8 t set f edge);
void R ICU IRQSetRisingEdge (const uint8 t irg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */

Now, open the Config_ICU.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

[ KKK KK KKK KKK KKK kKK KKK K KKK KKK KK KK Kk Kk ok ok ok ok R R K K KRR K K K K Kk ks ko ok ok ok K R R A AR K K Kk ok kR ok ok ok ok

* Function Name: R _ICU IRQIsFallingEdge

* Description : This function returns 1 if the specified ICU IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8_t irg no

* Return Value : 1 if falling edge triggered, 0 if not

*******************************************************************************/
uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no)

{
uint8 t falling edge trig = 0x0;

if (ICU.IRQCR[irg no].BYTE & _04 ICU IRQ EDGE_FALLING)
{

falling edge trig = 1;
}

return (falling edge trig);

}

/*******************************************************************************

* End of function R ICU IRQIsFallingEdge

LR AR R EEEEEE e EEEE e EEEE Rt
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/*******************************************************************************

* Function Name: R ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if

* clearing

* Return Value : None
*******************************************************************************/

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set f edge)
{
ICU.IRQCR[irg no] .BYTE |= 04 ICU IRQ EDGE FALLING;

}

else

{
ICU.IRQCR[irqg no] .BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;

}

[ KKK K K K K kK K K R K K K R K KK R K K R kK K R K K K R K Kk ok Kk ok ok K ok K K ok Kk R ok K ok kK K ok K K ok K R R Kk ok Rk R ok K K

* End of function R _ICU IRQSetFallingEdge

********************************************************k**********************/

/*******************************************************************************

* Function Name: R ICU IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing

*

Return Value : None
*******************************************************************************/
void R_ICU IRQSetRisingEdge (const uint8 t irg no, const uint8 t set r edge)
{

if (1 == set_r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE RISING;
}
else
{
ICU.IRQCR[irg nol] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;
}
}

/******************************************************************************

* End of function R_ICU IRQSetRisingEdge

*******************************************************************************/

/* End user code. Do not edit comment generated here */
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Open the Config_ICU_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irq0_interrupt:

/* Start user code for r Config ICU irqg0 interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R _SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irq9_interrupt:

/* Start user code for r Config ICU irg9 interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */
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5.4.2 De-bounce Timer Code

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT1’ folder and open the ‘Config_CMT1_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the ‘Config_CMT1_user.c’ file insert the following code in the user code area inside the function
r_Config_CMT1_cmi1_interrupt:

/* Start user code for r Config CMT1 cmil interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT1 Stop();

/* Call the de-bounce call back routine */
R _SWITCH DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT2’ folder and open the ‘Config_ CMT2_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

Open the ‘Config CMT2_user.c’ file and insert the following code in the user code area inside the function
r_Config_CMT2_cmi2_interrupt:

/* Start user code for r Config CMT2 cmi2 interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R _Config CMT2 Stop();

/* Call the de-bounce call back routine */
R_SWITCH DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */
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5.4.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In §4.5.7 we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

extern volatile uint8_t g adc_trigger;

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘C Source Files’ folder and Open the file ‘SC_Tutorial.c’ and add the
highlighted code, resulting in the code shown below:

#include "r smc _entry.h"
#include "r h"
#include "r cg us efine.h"

#include "Config S12ADO.h"
#include "r rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6é t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the

code shown below:

void main (void)

{
/* Initialize the switch module */
R _SWITCH Tnit();

/* Set the call back function when SWl or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSKRX72T ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R _Config S12AD0_Start();

while (10U)
{
uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SWl or SW2) */
if (TRUE == g adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R _Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g adc_complete = FALSE;
}

else

{
/* do nothing */
}

}

Then add the definition for the switch call-back, get_adc and lcd_display_adc functions adding at the below of

the main function, as shown below:

/******************************************************************************

* Function Name : cb switch press

* Description : Switch press callback function. Sets g adc trigger flag.
* Argument : none

* Return value : none

******************************************************************************/

static void cb_switch press (void)

{
/* Check if switch 1 or 2 was pressed */
if (g switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))
{
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/* set the flag indicating a user requested A/D conversion is required */

g_adc_trigger = TRUE;

/* Clear flag */
g_switch flag = 0x0;
}
}

/******************************************************************************
* End of function cb switch press

******************************************************************************/
/******************************************************************************

* Function Name : get adc

* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.

* Argument : none

* Return value : uintl6_t adc value

******************************************************************************/
static uintlé t get adc (void)

/* A variable to retrieve the adc result */
uintlé_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R Config S12AD0_Stop()

/* Start a conversion */
R S12AD0 SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g adc_complete)
{
/* Wait */
}

/* Stop conversion */
R _S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g adc_complete = FALSE;

R Config S12AD0O Get ValueResult (ADCHANNELO, &adc_ result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R_Config S12ADO_Start();

return (adc_result);

}

/******************************************************************************

* End of function get adc
******************************************************************************/

/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

******************************************************************************/
static void lcd_display_adc (const uintlé_t adc_result)
{

/* Declare a temporary variable */

uint8 t a;

/* Declare temporary character string */
char lcd buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t) ((adc_result & 0x00F0) >> 4);
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lcd buffer([7] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (uint8 t) (adc_result & 0xO000F);
lcd buffer[8] = (char) ((a < 0x0A) 2 (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd buffer */
R_LCD Display(3, (uint8 t *)lcd buffer);

}

/**********************************************************k*******************

* End of function lcd display adc

******************************************************************************/

In the Project Tree, expand the ‘Smart Configurator\Config_S12AD0’ folder and open the file
‘Config_S12AD0.h’ by double-clicking on it. Insert the following code in the user code area for function,
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R S12AD0 SWTriggerStart (void) ;
void R_S12AD0_SWTriggerStop (void) ;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_S12AD0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R S12AD0 SWTriggerStart
* Description : This function starts the ADO converter.
* Arguments : None
* Return Value : None
*******************************************************************************/
void R_S12AD0_SWTriggerStart (void)
{

IR(S12AD, S12ADI) = 0U;

IEN(S12AD, S12ADI) = 1U;

S12AD.ADCSR.BIT.ADST = 1U;
}

/*******************************************************************************

End of function R S12AD0 SWTriggerStart
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/*******************************************************************************
* Function Name: R S12AD0 SWTriggerStop
* Description : This function stops the ADO converter.
* Arguments : None
* Return Value : None
*******************************************************************************/
void R _S12AD0 SWTriggerStop (void)
{

S12AD.ADCSR.BIT.ADST = 0U;

IEN(S12AD, S12ADI) = 0U;

IR(S12AD, S12ADI) = 0U;
}

/*******************************************************************************

End of function R S12AD0 SWTriggerStop
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/* End user code. Do not edit comment generated here */
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Open the file Config_S12AD0_user.c and insert the following code in the user code area for global, resulting in
the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_S12ADO0 _interrupt function, resulting in the
code shown below:

static void r Config S12AD0_interrupt (void)
{

/* Start user code for r Config S12AD0 interrupt. Do not edit comment generated here */

g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

}
Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.
The project may now be run using the debugger as described in §6. When any switch is pressed, the

program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the SC_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Locate the files r_rsk_debug.h and
r_rsk_debug.c in this folder. Copy these files into the C:\Workspace\SC_Tutorial\src folder. Add these two files
into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL DEBUG WRITE (R SCI11 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Smart Configurator\Config SCI11’ folder and open the file
‘Config_SCI11.h’ by double-clicking on it. Insert the following code in the user code area at the end of the file:
/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI1l AsyncTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI11_user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t gs scill txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI11_callback_transmitend function:

static void r Config SCI1l callback transmitend (void)
{
/* Start user code for r Config SCI1l callback transmitend. Do not edit comment generated here */

gs_scill txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area
inside the r_Config_SCI11_callback_receiveend function:

static void r_Config SCI11l callback receiveend(void)

{

/* Start user code for r Config SCI1l_callback_receiveend. Do not edit comment generated here */

/* Check the contents of g _rx char */
if (('c' == g_rx_char) || ('C' == g_rx_ char))
{
g_adc_trigger = TRUE;
}

/* Set up SCI1l receive buffer and callback function again */
R Config SCI1l Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/*******************************************************************************

* Function Name: R SCI1l AsyncTransmit

* Description : This function sends SCI1l data and waits for the transmit end flag.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

*******************************************************************************/
MD STATUS R _SCI1l AsyncTransmit (uint8_ t * const tx buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
gs_scill txdone = FALSE;

/* Send the data using the API */
status = R Config SCI1l Serial_ Send(tx buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == gs_scill_ txdone)
{
/* Wait */
}
return (status);

}

/*******************************************************************************

* End of function R SCI1l AsyncTransmit
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5.6.2 Main UART code

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to above the ‘main’ function:

#include "r smc entry.h"
finclude "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI11.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6_t adc_ result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t gs_adc count, const uintlé t adc result);

/* Variable to store the A/D conversion count for user display */
static uint8 t gs adc count = 0;

Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R_SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R _SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)'" RSKRX72T ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0_Start();

/* Set up SCI1l receive buffer and callback function */
R Config SCI1l Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI1l operations */
R Config SCI11 Start();

while (10U)
{

uintl6 t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1l or SW2) */
if (TRUE == g adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc _result = get adc();

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the gs adc count */
if (16 == (++gs_adc count))
{

gs_adc_count = 0;

}

/* Send the result to the UART */
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uart display adc(gs_adc_count, adc result);

/* Reset the flag */

g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g adc complete)
{

/* Get the result of the A/D conversion */
R _Config S12AD0O_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the gs adc count */
if (16 == (++gs_adc_count))
{

gs_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(gs_adc_count, adc result);

/* Reset the flag */
g_adc_complete = FALSE;
}

else
{

/* do nothing */
}

Then, add the following function definition in the end of the file:

/******************************************************************************

* Function Name : uart display adc

* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8_t : gs_adc count

* uintlé_t: adc result

* Return value : none

******************************************************************************/
static void uart display adc (const uint8 t gs adc count, const uintlé6_t adc result)

{

/* Declare a temporary variable */
char a;

/* Declare temporary character string */
static char uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char) (gs_adc_count & 0x000F) ;

uart buffer([4] = (char) ((a < 0xO0A) ? (a + 0x30) : (a + 0x37));
a = (char) ((adc_result & 0x0F00) >> 8);

uart _buffer([14] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char) ((adc_result & 0x00F0) >> 4);

uart buffer([15] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char) (adc_result & 0x000F);

uart buffer[16] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R_DEBUG_Print (uart_buffer);
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* End of function uart display adc
******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.
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The project may now be run using the debugger as described in §6. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &
LPT)' as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI11 (see §4.5.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the SCI11. Return to this point in the SC_Tutorial to add the LED user code.

5.7 LED Code Integration

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to the above the ‘main’ function:

#include "r smc entry.
#include "r va 1
#include
#include
#include
#include _rsk_

#include "Config ¢
#include "rskrx72tdef.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t gs adc count, const uintl6 t adc result);

/* Variable to store the A/D conversion count for user display */
static uint8 t gs adc count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R _SWITCH Tnit();

/* Set the call back function when SWl or SW2 is pressed */
R_SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSKRX72T ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();
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/* Set up SCI1l receive buffer and callback function */
R Config SCI1l Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI1l operations */
R _Config SCI11 Start();

while (10)
{

uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the gs_adc_count and display using the LEDs */
if (16 == (++gs_adc_count))
{
gs_adc_count = 0;
}

led display count(gs_adc_count) ;

/* Send the result to the UART */

uart display adc(gs_adc_count, adc result);

/* Reset the flag */

g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g adc_complete)
{

/* Get the result of the A/D conversion */

R Config S12AD0O Get ValueResult (ADCHANNELO, &adc_ result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the gs_adc_count and display using the LEDs */
if (16 == (++gs_adc_count))
{
gs_adc_count = 0;
}

led display_count (gs_adc_count) ;

/* Send the result to the UART */
uart display adc(gs_adc_count, adc result);
/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}
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Then, add the following function definition in the user code area at the end of the file:

/******************************************************************************

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDSO0-3
* Argument : uint8 t count

* Return value : none

AR EEEE AR EEEEE SRR EEEE R EE Rl

static void led display count (const uint8 t count)

{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8 t) ((count & 0x01) ? LED ON : LED OFF);

)
LEDl = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8 t) ((count & 0x04) ? LED ON : LED OFF);
) 2 )i

LED3 = (uint8_ t) ((count & 0x08 LED_ON : LED OFF);

}

VAR E R EEEE RS SRR EEEEE AR R R

* End of function led display count
R R R R R R R R R R R R R R R R R I I I I I b I b b b b b b b b b b b i i g

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The code will perform the same but now

the LEDs will display the gs_adc_count in binary form.
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6. Debugging the Project

6. Debugging the Project

e In the ‘Project Tree’ pane, right-click the
‘RX Simulator (Debug Tool).  Select

Project Tree

: © 3 |[E

Using Debug Tool -> RX E2 Lite'. =L SC Tutorial (Project”
: 3:% R5F3T2TKCxFB (Micracantroller)
_~| Srnart Configurator (Design Teol)
CC-RX (Build Tool)
T’ Program Analyze Using Debug Tool  » | R¥ E2
il o
= _?!-I"jeBuildtool ge Property RX EZ Lite
I_l Smart Configurator RX E1(Serial)
i ], C Source Files RX E1(JTAG)
L Dependencies RX E20(Serial)
RX E20(JTAG)
RX Simulator
o Double-click ‘RX E2 Lite (Debug Tool)’ to Property
display the debugger tool properties. | |5 rxezpropety
Under ‘Clock’, change the main clock | |v Iniernal ROMRAM
oo | Size ofinternal ROM[KBytes) ___________________j(i
frequency to 8 MHz, Communications Size of intemal RAM[KBytes] 14
method ‘JTAG’ and operating frequency to | | g /0ot merenl@ri] e
ZOOMHZ, Main clock source EXTAL
. i Main clock frequency[MHz] 8.0000
e Under ‘Connection with Target Board’, Operating frequency[MHz] 200.0000
¢ Allow changing of the clock source on writing internal flash memony Mo
change ‘Power target from the emulator. | |+ connectionuit
(MAX 200mA) to *Yes'.  Commecton b oo
e All other settings can remain at their e o A 200 ety
Supply voltage [V] 33
defaults. Cz:r'\)nj\(u ;?c:t?:ns method JTAG
e Connect the E2 Lite to the PC and the
RSK E1/E2 Lite connector. Connect the
Pmod LCD to the PMOD1 connector.
e From the ‘Debug’ menu select ‘Download’
to start the debug session and download
code to the target.
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7. Running the Smart Configurator Tutorial

71 Running the Tutorial

Once the program has been downloaded onto the RSK device, the program can be executed.
Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

®
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8. Additional Information

Technical Support
For details on how to use CS+, refer to the help
file by opening CS+, then selecting Help > Help Tool Window | Help |

Contents from the menu bar. 5 o | @)@ vep
) | & r‘ g Q Cpen Help for Start Panel F1
é@ Start How to Access Help 4
- @ﬂ One Point Advice...
Le B Tutorial

@] Browse Renesas Electronics Microcontrollers Web
ié Privacy Settings...

(i Detail Version Information...

Crq =
{ g Check for Updates...

bgg About.

For information about the RX72T group microcontroller refer to the RX72T Group Hardware Manual.
For information about the RX assembly language, refer to the RX Family Software Manual.
Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright
This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of

this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe Limited.

© 2018 Renesas Electronics Europe Limited. All rights reserved.
© 2018 Renesas Electronics Corporation. All rights reserved.
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